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1 JOHDANTO 

 

 

Tämän opinnäytetyön tarkoitus on toimia oppaana Google Play Service -pelipalveluiden lisäämiseen 

mobiilipeliin Unity3D-pelimoottoria käytettäessä. Unity3D-pelimoottori on tällä hetkellä suosituin pe-

limoottori pelinkehittäjien keskuudessa. Ohjelmointikielenä käytetään C#-olio-ohjelmointikieltä, jota 

Unity3D-pelimoottori tukee. Opinnäytetyö olettaa, että lukijalla on perustietämys Unity3D-pelimootto-

rin käytöstä sekä hallussa C# olio-ohjelmoinnin perusteet.  

 

Opinnäytetyössäni opastetaan vaiheittain Google Play -pelipalveluiden lisääminen ja selitetään, kuinka 

nämä ohjelmoidaan Unity3D-pelimoottorissa. Lisäksi ohjeistetaan, kuinka sovellus julkaistaan Google 

Play-kauppaan sisäisenä testinä. Ohjeistusta täydentää runsas opastavien kuvien määrä. Käytän opin-

näytetyössä esimerkkinä omaa mobiilipeliäni, joka on ollut henkilökohtaisena projektinani koko opin-

näytetyön tekemisen ajan. Lähteinä käytän pääasiassa internetin Android-sovelluskehittäjien ohjelmoin-

tioppaita. 
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2 ALUSTAT JA OHJELMISTOTEKNIIKAT 

 

 

Tarjolla on paljon pelinkehitykseen soveltuvia työkaluja, joista monet ovat saatavilla edullisesti tai jopa 

ilmaiseksi. Tärkeimpiä työkaluja ovat valmiit pelimoottorit, jos ei ole päättänyt tehdä pelimoottoriaan 

itse, mikä on haastava ja aikaa syövä prosessi. Pelimoottori on videopeliohjelmistokehys, joka on suun-

niteltu videopelien tekemiseen ja kehittämiseen.  Isot peliyritykset saattavat päättää tehdä oman peli-

moottorinsa peleilleen, mutta pelimoottorin kehitykseen menee valtavasti aikaa ja resursseja. Yhä har-

vempi harrastelija tai pienempi peliyritys lähtee rakentamaan omia pelimoottoreita, koska ajan käyttä-

minen muun muassa fysiikkamoottorin ja kuvantamismoottorin luomiseen vie valtaosan pelinkehityk-

seen varatusta ajasta ja resursseista.  Tällä hetkellä suosituimmat ilmaiseksi käytettävät pelimoottorit 

ovat Unity Technologiesin ylläpitämä Unity ja Epic Gamesin kehittämä Unreal Engine. 

 

 

2.1 Unity Engine -pelimoottori 

 

Unity on monialustainen pelimoottori, jonka Unity Technologies on kehittänyt. Unityllä voidaan kehittää 

kaksi- ja kolmiulotteisia selain-, konsoli-, mobiili- ja PC-pelejä. Grafiikan renderöinnissä Unity hyödyn-

tää Box2D- ja Nvidian PhysX-fysiikkamoottoria. Pelimoottorista on saatavilla ilmaisen Unityn lisäksi 

maksulliset Unity Plus- (35€/kk) ja Unity Pro (125$/kk)-versiot sekä yrityksille neuvoteltavissa oleva 

Enterprise -versio. Jos peli, joka on luotu Unityn ilmaisella Personal versiolla, tuottaa yli 100.000 $ 

liikevaihtoa vuodessa, joutuu Unitylle maksamaan osan liikevaihdosta/tuloista. Unity Plus -versiossa 

raja on 200.000 $, ja Pro-versiossa ei joudu maksamaan mitään. 

 

Unity on ennen tukenut C#-ohjelmointikielen lisäksi UnityScriptiä, joka on Javascriptiä käyttävä ohjel-

mointikieli, sekä Boo-ohjelmointikieltä. Boo-kielen käyttö oli niin vähäistä, että Unity poisti sen tuke-

misen vuonna 2014. Yleinen kysymys viime vuosina aloittelevilla Unityn käyttäjillä on ollut valinta 

C#:n ja UnityScriptin väliltä, mutta suurin osa on kuitenkin päätynyt C#-kieleen, koska suurin osa ole-

massa olevasta Unityä käsittelevästä materiaalista käyttää C# kieltä. 10 heinäkuuta 2018 Unity poisti 

UnityScirptin tuen kokonaan jättäen C#:n ainoaksi vaihtoehdoksi, koska UnityScriptin käyttö oli ollut 

jo vuosia niin vähäistä, että sen tukeminen ei ole enää järkevää. 
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2.2 C# -Ohjelmointikieli 

 

C# on moderni, yksinkertainen, olio-orientoitunut ja tyyppiturvallinen korkeamman tason 
ohjelmointikieli. Samalla C# on ensimmäinen komponenttisuuntautunut ohjelmointikieli 
C/C++-kieliperheessä. C#:n suunnitteluun ja kehittämiseen vaikuttivat monet muut olio-
orientoituneet kielet, kuten esimerkiksi C++, SmallTalk ja Java. Päämääränä oli luoda 
kieli, jossa on laajentuva tyyppijärjestelmä, 1. luokan komponenttien tuenta, luotujen oh-
jelmien vakaus ja näiden versioiden hallinta sekä yhteensopivuus aiemmin tehtyjen ohjel-
mistojen ja komponenttien kanssa. Tavoitteena oli myös luoda kieli, joka yhdistää MS Vi-
sual Basicin tuottavuuden ja C++:n tehon. (Sivonen 2004. 1)  

 

Uusin C#-versio on 7.3, mutta tällä hetkellä Unity-versio 2018.2. tukee C#-versiota 7.2, jota käytän tätä 

opinnäytetyötä tehdessäni. Luultavasti seuraavassa Unityn päivityksessä lisätään tuki C#-versiolle 7.3. 

 

 

2.3 Android-käyttöjärjestelmä 

  

Päätin valita opinnäytetyössäni käytettäväksi käyttöjärjestelmäksi Androidin, koska se on laajimmassa 

käytössä oleva mobiililaitteiden käyttöjärjestelmä ja opinnäytetyön laajuus olisi kasvanut liian suureksi, 

jos olisin käsitellyt useampaa käyttöjärjestelmää. Android on Googlen julkaisema ja jatkuvassa kehityk-

sessä oleva avoimen lähdekoodin käyttöjärjestelmä puhelimille ja muille mobiililaitteille. Koska 

Android on kaikista puhelimien käyttöjärjestelmistä laajimmassa käytössä oleva käyttöjärjestelmä, 

hyöty mobiilipelin kehittämisestä Androidille on se, että mahdollisia asiakkaita on paljon. Koska 

Android on todella laajassa käytössä, se tarkoittaa myös sitä, että Androidille on olemassa sovelluksia ja 

pelejä todella paljon ja niitä tulee lisää päivittäin, mikä taas lisää haastetta pelin näkyvyydelle, kun tar-

jontaa on todella paljon. Vähemmässä käytössä olevalle alustalle kehittäessä muiden sovellusten määrä 

laskee ja näin ollen tämä mahdollisesti parantaa oman sovelluksen näkyvyyttä. Nykypäivänä pelin kään-

täminen toiselle alustalle on helpottunut paljon ja muun muassa Unity-pelimoottorilla voidaan peli kään-

tää suhteellisen nopeasti mille vain alustalle, jolloin pelintekijä pystyy halutessaan kehittämään pelinsä 

kaikille yleisimmille käyttöjärjestelmille. 

 

2.4 Google Play -pelipalveluiden ohjelmointirajapinta 

 

Google Play -pelipalvelut (Eng. Google Play Game Services) on Googlen kehittämä ohjelmointiraja-

pinta, joka sisältää videopeleille hyödyllisiä palveluita, joita voidaan lisätä videopeliin. Näitä palveluita 
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ovat tulostaulukkojen (Eng. Leaderboards) ja saavutusten (Eng. Achievements) luominen peliin, reaali-

aikaisen ja vuoropohjaisen moninpelin mahdollistaminen sekä pelin edistymisen tallentaminen ”Tallen-

netut pelit” (Eng. Saved Games) -palvelulla.  

Google Play poisti muutamia ominaisuuksia pelipalveluista, kuten lahjat, pyynnöt ja tehtävät (Eng. 

Gifts, Requests and Quests) niiden vähäisen käytön vuoksi 2018 maaliskuussa. Tästä ilmoitettiin vuosi 

takaperin, jotta kyseisiä ominaisuuksia käyttäneet kehittäjät saivat aikaa valmistautua muutokseen. 

(Android Developers Blog 2017.) 

 

 

2.5 Google Play services -sovellus 

 

Google Play services on komponenttisovellus, jota käyttäjä ei voi käynnistää ja joka asentuu oletuksena 

jokaiselle Android-laitteelle (KUVA 1). Tämä sovellus tarjoaa ydintoimintoja, ja sen kautta kulkevat 

päivitykset Google- ja Google Play -sovelluksille. Google Play services on mahdollista kytkeä pois 

päältä, mutta tämä johtaa hyvin todennäköisesti eri sovellusten toimimattomuuteen. 

 

 
KUVA 1. Google Play services -sovellus 

 

Google Play services -sovellus toimii taustalla ja päivittyy automaattisesti Google Play -kaupan toimesta 

(KUVIO 1). Sovellukset kommunikoivat Google Play services -sovelluksen kanssa käyttämällä sovel-

luksessa asiakaskirjastoa (Eng. Client Library). Sovelluksen kehittäjän tulee päivittää tämä asiakaskir-

jasto, jos hän haluaa käyttää uusia Google Play -palveluiden ominaisuuksia, mutta muuten asiakaskir-
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jastoa ei tarvitse päivittää, vaikka Google Play -palvelut saisivatkin uusia ominaisuuksia päivitysten mu-

kana.  Google Play services -sovellus vastaava palveluiden toimivuudesta eri laitteilla ja näin ollen hel-

pottaa sovellustenkehittäjiä, koska heidän ei tarvitse huolehtia eri laitteiden tukemisesta Google Play -

palveluiden osalta. 

 

 
KUVIO 1. Google Play palveluiden päivitysten toimintamalli (mukaillen Google Play 2018.) 

  

IRC 

Sinun sovellus 
Google Play  

services -sovellus 

Google Play  

-kauppa 

Client Library 

Hiljaiset 

päivitykset 
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3 ANDROID-YMPÄRISTÖN KÄYTTÄMINEN UNITY-PELIMOOTTORISSA 

 

 

3.1 Android SDK- ja Java JDK -pakettien asennus  

 

Ensiksi tietokoneelle tulee asentaa Androidin käyttämä Java Development Kit (JDK). Unity vaatii 64-

bittisen JDK 8 (1.8) -version. Tämän lisäksi asennetaan Android SDK (Software Development Kit). 

Android SDK:n voi asentaa komentorivityökaluilla tai Android Studion avulla. Android Studio tarjoaa 

SDK -pakettien asentamiseen helppokäyttöisen graafisen käyttöliittymän nimeltä ”SDK Manager”. Itse 

asensin Android SDK:n käyttäen SDK Manageria. SDK Manager käynnistetään Android Studiossa pai-

namalla Tools > Android > SDK Manager tai painamalla SDK Manager -nappia työkalurivillä. Lisäksi 

tulee katsoa polku, jonne SDK-paketti asentuu, koska sitä tarvitaan myöhemmin Unity Editorissa.  

 

Unity tarvitsee viittaukset Javan JDK-pakettiin ja Androidin SDK-kehittäjäntyökaluihin. Unity Edito-

rille pitää kertoa polku näihin kansioihin asetuksista menemällä Edit > Preferences > External Tools 

ja kirjoittamalla tarkka polku JDK- ja SDK-sijanteihin (KUVA 1). Itse kohtasin tässä vaiheessa paljon 

virheilmoituksia Unityltä, koska Unity ei hyväksynyt JDK:ta tai SDK:ta jostain syystä. Ongelma ratkesi 

poistettuani kaikki vanhat JDK- ja SDK-paketit koneeltani ja asennetuani ne uudestaan. Vasta sitten 

Unity hyväksyi polut paketteihin. 

 

 
KUVA 2. External Tools ja JDK-/SDK-polut asetettuna 
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3.2 Android-alustan valinta ja asetukset 

 

Unityssä tulee vaihtaa projektin alusta, jos sitä ei ole valittu haluttuun muotoon heti projektia luotaessa. 

Alusta vaihdetaan Build Settings -valikosta, jonne pääsee menemällä File > Build Settings. Sieltä alus-

taksi voi valita Android-alustan ja hyväksyä muutoksen napilla Switch Platfrom (KUVA 3).  

 

 
KUVA 3. Build Settings ja Android-alusta valittuna 

 

Lisäksi tulee Build Settings valikossa vetää ja tiputtaa kaikki halutut scenet kohtaan Scenes In Build ja 

järjestää ne niin, että pelin ensimmäinen käynnistyvä scene on ylimpänä numerona 0. Kuva 2:n esimer-

kissä scene nimeltä ”Persistent” käynnistyy ensimmäisenä sovelluksen käynnistyessä. 

 

Tämän jälkeen avataan lisävalikko valitsemalla Player Setting, jonne pääse Build Settings -valikosta 

myös. Valitaan Resolution and Presentation ja haluttu Default Orientation, eli missä asennossa peli 

tahdotaan näkyvän laitteen ruudulla. Yllä olevan kuva 2:n esimerkissä orientation on asetettu automaa-

tille ja valittu Landscape Right/Left, eli peli kääntyy automaattisesti puhelinta käännettäessä mutta vain 

horisontaalisesti. Pelin logon, eli miten peli näkyy sovelluslistassa mobiililaitteella, voi vaihtaa kohdasta 
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Icon valitsemalla Enable Android Banner ja asettamalla pelin kuvakkeen. Valitaan seuraavaksi Other 

Settings Player Settings -valikosta ja asetetaan Bundle Identifier muodossa com.<yrityksesi-

nimi>.<sovelluksennimi>. On tärkeää huomioida, että tämän Bundle ID:n tulee olla sama Google Play 

Console -sivustolla sekä Unity Editorin puolella, jotta järjestelmät osaavat käsitellä samaa sovellusta. 

 

3.3 Android-mobiililaitteen valmistelu USB-testausta varten 

 

Kehittäessä sovellusta Androidille tulee sovellusta testata myös fyysisellä mobiililaitteella. Jotta sovel-

lusta päästään testaamaan kunnolla, tulee Android-laitteella aktivoida kehittäjän asetukset. Kehittäjän 

asetukset kytketään päälle menemällä Android-mobiililaitteella Settings > About phone > Build num-

ber. Kun ohjelmistoversion numeroa (Eng. Build Number) painetaan seitsemän kertaa, laite ilmoittaa, 

että kehittäjän asetukset on aktivoitu. Laitteen asetuksista löytyy nyt alavalikko kehittäjän asetukset, 

josta voidaan sallia USB Debugging. Tämä mahdollistaa testaamisen USB-kaapelin välityksellä, joka 

on normaalisti kytketty pois päältä. 

 

Unity on luonut USB-testaamista varten sovelluksen nimeltä Unity Remote, jonka voi ladata Android-

laitteelle Google Play -kaupasta ilmaiseksi. Unity Editorin asetuksista Edit > Project Settings > Editor 

tulee valita laite, jota käytetään Unity Remotessa. (Katso KUVA 4)  

 

 
KUVA 4. Unity Remote -asetukset 

 

Unity Remotella testatakseen käyttäjän tulee kytkeä testauslaite tietokoneeseen USB-kaapelilla ja käyn-

nistää Unity Remote testauslaitteella. Muuta Unity Remotessa ei tarvitse käynnistämisen lisäksi tehdä. 

Painamalla Unity Editorissa Play, kopioituu pelinäkymä Unity Remoten avulla kännykälle alhaisem-

malla kuvataajuudella. Prosessointi tapahtuu kuitenkin editorissa, joten suorituskyvyn testaamiseen 
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Unity Remote ei sovellu. Kuitenkin kaikki laitteen syötteet, kuten painallukset ja laitteen sensorien tie-

dot, lähetettään suoraan Unity Editoriin. 

 

 

3.4 Sovelluksen allekirjoittaminen ja APK tiedoston rakentaminen 

 

Tässä vaiheessa APK-tiedoston luominen on mahdollista. Jotta pelin pystyy laittamaan Google Playn 

järjestelmään, tulee sovelluksen olla allekirjoitettu. Seuraavaksi tulee siis luoda uusi avain sovelluksen 

allekirjoittamista varten, jos olemassa olevaa avainta ja avainsäilöä ei ole jo luotu. Tämä avain ja sen 

salasana ovat tärkeitä, ja niitä ei saa missään nimessä hukata. Niitä tarvitaan myöhemmin, jotta voidaan 

luoda uusi APK-tiedosto projektista ja julkaista se Google Play -kauppaan päivityksenä. Avainvarasto 

tulee säilyttää tallessa, jotteivat muut pääse siihen käsiksi, koska avaimen avulla on mahdollista julkaista 

päivitys peliin ja sisällyttää siihen esimerkiksi haittaohjelmia. 

 

 
KUVA 5. Unity Editorin Player Settings ja Publishing Settings 
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Uusi avainvarasto luodaan Build Settings > Player Settings > Other Settings (KUVA 5) -kohdassa 

laittamalla rasti ruutuun Create a new keystore ja valitsemalla haluttu tallennuspaikka avainvarastolle. 

Tämän jälkeen asetetaan keystore password kahteen kertaan. Lisäksi tulee luoda yksi avain varastoon 

kohdassa key. Tästä lähtien käyttäjän tulee aina kirjoittaa sekä keystoren ja aliaksen salasana, jotta hän 

voi rakentaa APK-tiedoston projektistaan. Menemällä kohtaan build settings ja sieltä painamalla nappia 

Build voidaan luoda APK-tiedosto, joka voidaan sitten siirtää mobiililaitteelle asennettavaksi ja pelatta-

vaksi. Tämä sama tiedosto laitetaan myöhemmin Google Play -kauppaan jakoon sisäiseen testiin. 
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4 PELIN JULKAISU GOOGLE PLAY KEHITTÄJÄKONSOLISSA 

 

 

Tässä luvussa käydään läpi, kuinka peliprojekti lisätään, rekisteröidään ja julkaistaan sisäisenä testinä 

Google Play Consolessa. Sisäinen testi on sovelluksen julkaisu, jonka voivat ladata vain valitut henkilöt 

eli testaajat, joille on lähetetty liittymislinkki.  

 

Aluksi tulee luoda uusi Google-kehittäjätili tai tehdä olemassa olevasta Google-tilistä kehittäjätili. Ke-

hittäjätilin voi tehdä osoitteessa https://play.google.com/apps/publish/signup/ ja maksamalla 25 euron 

liittymismaksun. Muita maksuja kehittäjätilin käyttöönotossa ei ole. Googlen kehittäjätilin aktivoiminen 

on nopeaa ja helppoa sekä edullista verrattuna Applen sovelluskaupan kehittäjätilin vuotiseen 100 euron 

maksuun.  

 

 
KUVA 6. Google Play Console 

 

Tämän jälkeen peli tulee rekisteröidä, jotta Play Game Services -ominaisuuksia pääsee käyttämään. Peli 

rekisteröidään painamalla vasemmasta laidasta ”Pelipalvelut” (KUVA 6) ja valitsemalla tämän jälkeen 

”Lisää uusi peli”. Sitten syötetään pelin nimi, kategoria, muut pakolliset kentät ja painetaan tallenna 

(KUVA 7). 
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KUVA 7. Google Play Console ja Pelipalvelut 

 

Seuraavaksi voidaan ladata sivustolle itse peli APK-tiedostona. Peliä ei voi julkaista ennen kuin kaikki 

vähimmäistiedot on täytetty. Näitä kuvaavat vasemmassa laidassa olevat ympyrät, jotka muuttuvat vih-

reiksi, kun kaikki vaadittavat kentät on täytetty (KUVA 8). 

 

 
KUVA 8. Sovellusjulkaisut-sivu, kun peli on valmiina julkaistavaksi 
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Tämän jälkeen pitää odottaa, että julkaisu hyväksytään. Kun peli on julkaistu, saa linkin, jolla pelin 

lataaja ja muut sisäiset testaajat saavat pelin ladattua itselleen Google Play Store -palvelusta. (KUVA 9) 

 

 
KUVA 9. Sisäisen testin Google Play -kauppanäkymä 

 

Google Playn sisäinen testaus on hyödyllinen, kun testaajia on enemmän kuin yksi tai kun halutaan 

testata Google Play Store -palvelun ulkonäköä. Huomasin kuitenkin, että pelin testaaminen yhdellä lait-

teella paikallisesti on nopeampaa käyttämällä Unity Remotea ja testaamalla sitä USB-kaapelin kautta. 

Vaihtoehtoisesti voi tehdä APK-tiedoston ja siirtää sen omalle kännykälle, jota suosin enemmän kuin 

Unity Remote -sovelluksen käyttöä. Pelin testaaminen mobiililaitteella APK-tiedoston siirrolla mahdol-

listaa Google Play -ominaisuuksien testaamisen, kun taas USB-kaapelilla tai Unity Editorissa testatessa 

nämä ominaisuudet eivät ole käytettävissä. 
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5 GOOGLE PLAY -PELIPALVELUIDEN KÄYTTÖÖNOTTO UNITY -PELIMOOTTORISSA 

 

 

Tässä luvussa käydään läpi, miten Google Play Games Services (GPGS) -palvelun tarjoamia perusomi-

naisuuksia, kuten kirjautumisen omalle tilille, tulostaulukoita sekä palkintoja, implementoidaan pelipro-

jektiin Unity-pelimoottorissa. 

 

 

5.1 Google Play Games Unity Pluginin lisääminen Unity-pelimoottoriin 

 

Ensiksi tulee ladata Unity Google Play Services -paketti osoitteesta https://github.com/playgameservi-

ces/play-games-plugin-for-unity koneelle ja tuoda tämä paketti Unity-projektiin valitsemalla Unity Edi-

torista Assets > Import Package > Custom Package ja valitsemalla ladattu Google Play Games Plugin 

-paketti (KUVA 10). Suosittelen tuomaan kaikki Google Play Games Plugin -paketin mukana tulevat 

tiedostot, koska jos jättää esimerkiksi multiplayer-kansion tuomatta, Unity ilmoittaa useasta virheestä 

eri skripteissä, koska viitattu multiplayerkansio puuttuu.  

 

 
KUVA 10. Import Unity Package 

 

Nyt skripteissä voidaan viitata Google Play Games Plugin -paketin mukana tulleisiin skripteihin, jotka 

mahdollistavat Google Play -ominaisuuksien lisäämisen pelin koodissa. 

 

https://github.com/playgameservices/play-games-plugin-for-unity
https://github.com/playgameservices/play-games-plugin-for-unity
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5.2 Google Play -kirjautuminen 

 

Ennen kuin pelaajat pääsevät käyttämään Google Play -ominaisuuksia, tulee heidän kirjautua Google-

tililleen pelissä. Tässä kappaleessa käydään läpi, kuinka Google Play -kirjautuminen lisätään peliin. Kir-

jautuminen Google Play -palveluun voidaan suorittaa heti pelin käynnistyessä. Tämä ei kuitenkaan riitä, 

sillä Google Play vaatii, että peli sisältää mahdollisuuden kirjautumiseen sekä uloskirjautumiseen nap-

pien muodossa.  

 

Aivan ensiksi ludaan skripti nimeltä GooglePlayOminaisuudet.cs, joka käynnistää Google Play Servi-

cen ja pyytää pelaajalta kirjautumista heti, kun peli käynnistyy. Sijoitetaan tämä skripti Unityn ensim-

mäiseen sceneen, joka käynnistyy Unityssä ensimmäisenä, kun peli käynnistetään.  

 

Seuraavaksi lisätään kirjastot GooglePlayGames ja GooglePlayGames.BasicApi, jotka mahdollistavat 

viittaamisen yleisimpiin Google Play Plugin -liitännäisen mukana tuleviin skripteihin. Unityn oma funk-

tio Awake on funktio, joka ajetaan jokaisessa skriptissä ensimmäisenä, kun GameObject-peliobjekti la-

tautuu. Alustetaan Awake funktiossa PlayGamesPlatform ja luodaan oma GoogleSignIn -funktio, jossa 

suoritetaan kirjautumispyyntö komennolla Social.localUser.Authenticate(). (KUVA 11) Tämän jälkeen, 

kun peli käynnistetään, ruutuun tulee Google Play -kirjautumisen ruutu.  

 

 
KUVA 11. Google Play -kirjautumisen skripti 
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Tulen luomaan peliin kaksi valikkoa, joista vain toinen voi olla päällä kerralla riippuen siitä, onko pe-

laaja kirjautunut vai ei. Tätä varten lisätään GooglePlayOminaisuudet-skriptiin muuttujat connected-

Menu, disconnectedMenu ja usernameText. Luon uuden funktion OnConnectionResponse(bool aut-

henticated), joka aktivoi kirjautumisvalikon tai uloskirjautumisvalikon riippuen boolean arvosta, jonka 

se saa kutsun aikana (katso KUVA 12 alla). Lisäksi jos pelaaja on onnistuneesti kirjautunut, näytämme 

usernameText -kentässä pelaajan Google Play -käyttäjänimen skriptillä Social.localUser.userName. Kut-

sutaan OnConnectionResponse -funktiota GoogleSignIn -funktiossa antamalla boolean arvo true tai 

false riippuen onko kirjautuminen onnistunut (katso KUVA 11 yllä). 

 

 
Kuva 12. Kirjautumisvalikkojen toimintakoodi 

 

Luodaan Unity Editorissa napit Kirjaudu sisään ja Kirjaudu Ulos. Lisätään nämä napit omiin ryh-

miinsä nimeltä GPconnectedMenu ja GPdisconnectedMenu. Kun pelaaja on kirjautunut, ”GPconnec-

tedMenu” näyttää nappi vaihtoehdot LogOut, Achievements ja Leaderboards. Kun pelaaja taas kir-

jautuu ulos, kytketään GPconnectedMenu pois päältä ja aktivoidaan GPdisconnectedMenu, joka si-

sältää pelkästään napin Kirjaudu Sisään. (Katso kuvan 13 vasemmalla oleva hierarkianäkymä.) 

 

Asetetaan jokaisen nappi-peliobjektin Button -komponentin viittaus GooglePlayOminaisuudet -skriptiin 

vetämällä tämän skriptin sisältävä peliobjekti On Click() -kenttään. Sitten valitaan jokaiselle napille ha-

luttu funktio GooglePlayOminaisuudet -skriptistä. (KUVA 13) Valitaan KirjauduSisään -napille 
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GoogleSignIn -funktio ja KirjauduUlos -napille GoogleSignOut -funktio. Lisätään Saavutukset- ja 

Tulostaulu -napeille funktiot myöhemmin, kun funktiot on ensiksi luotu. 

 

 
KUVA 13. Unity Editori ja luodut GameObject -napit 

 

Luodaan APK-tiedosto ja siirrettään se mobiililaitteelle ja testataan kirjautumisen toimintaa. Jos kaikki 

on mennyt oikein, peli pyytää heti kirjautumista käynnistyessään. Tämän jälkeen connectedMenun pi-

täisi olla aktiivinen näyttäen käyttäjänimen sekä saavutukset-, tulostaulukot- ja kirjaudu ulos -napit. 

(KUVA 14) 

 

 
KUVA 14. Kuvakaappaus onnistuneesta Google Play -kirjautumisesta 

 

Kirjaudu ulos -nappia painettaessa disconnectedMenun pitäisi tulla näkyviin ja näkyvissä pitäisi olla 

vain Kirjaudu sisään -nappi alla olevan kuvan 15 tapaan. 
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KUVA 15. Kuvakaappaus kirjautumisvalikosta, kun pelaaja ei ole kirjautunut Google Play -palveluun 

 

 

5.3 Google Play -saavutukset 

 

Google Play -saavutukset (Eng. Achievements) ovat palkintoja, joita pelaaja voi saada pelatessaan peliä, 

joka käyttää Google Play -kirjautumista ja sisältää kyseisiä palkintoja. Yleisesti saavutukset viittaavat 

siihen, kuinka paljon pelistä on suoritettu tai kuinka paljon peliä on pelattu. Yleensä vain pieni osa kai-

kista pelin pelaajista kiinnittää huomiota palkintoihin, mutta juuri näiden pelaajien takia saavutukset 

kannattaa lisätä peliin, koska nämä pelaajat suurella todennäköisyydellä keräävät kaikki palkinnot ja 

näin ollen ovat pelin suurimpia faneja. 

 

Saavutukset lisätään Google Play Developer Consolen Pelipalvelut -valikon kohdasta Saavutukset. 

Vaihtoehtoina on lisätä kahdentyyppisiä saavutuksia, kerran avattavia ja monivaiheisia saavutuksia. Mo-

nivaiheisen saavutuksen luodakseen valitaan Osittaiset saavutukset saavutusta luodessa ja annetaan 

sille arvoksi, kuinka monta suoritusta kyseinen saavutus vaatii. 
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KUVA 16. Saavutuksen luonti 

 

Luon esimerkiksi saavutuksen nimeltä ”Aloittelija” ja annan kuvaukseksi ”Pelaa yksi kierros”, minkä 

lisäksi luon monivaiheisen saavutuksen nimeltä ”Onnenpekka” kuvauksella ”Kerää 10 kultakolikkoa”. 

Onnenpekka-saavutuksen vaiheitten määrä on kymmenen. (Katso KUVA 17) 

 

 
KUVA 17. Saavutukset -näkymä 

 

Kun saavutukset on luotu, painetaan saavutuslistan pohjalla olevaa Hae resurssit -linkkiä ja kopioidaan 

ruutuun tuleva XML-koodi. (KUVA 17) Nämä resurssit lisätään Unity Editorissa valitsemalla Windows 

> Google Play Games > Setup > Android Setup. (KUVA 18)  
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KUVA 18. Android -asetusten sijainti 

 

Liitetään kopioitu XML-koodi Resources Definition -kohtaan ja painetaan Setup (katso KUVA 19). 

Nyt koodissa voidaan viitata luotuihin saavutuksiin. Aina kun Google Play Developer Consolessa lisä-

tään uusi saavutus tai muu ominaisuus, kuten esimerkiksi tulostaulukko, tulee resurssit kopioida ja liittää 

uudestaan Unity Editoriin. Tämä mahdollistaa sen, että pystymme viittaamaan oikeaan saavutukseen tai 

asiaan koodissa.  

 

 
KUVA 19. Android Konfiguraatio -ikkuna 
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Lähdetään laajentamaan GooglePlayOminaisuudet.cs -skriptiä lisäämällä uusi funktio esimerkiksi ni-

mellä ShowAchievementUI(), jonka ajamalla suoritamme funktion Social.ShowAchievementUI(). 

Tämä käynnistää Google Playn oman Saavutukset-ikkunan pelin sisällä. Tämän lisäksi luodaan omat 

funktiot yksittäiselle sekä monivaiheiselle saavutuksille. Funktiot vaativat ID:n eli saavutuksen nimen, 

jonka tulee olla täsmälleen sama kuin Google Play -konsolissa tehdyn saavutuksen nimi. Lisäksi moni-

vaiheinen saavutus vaatii myös muuttuja arvon ”stepsToIncrement”, joka kertoo, kuinka monella aske-

leella saavutusta edistetään. (KUVA 20) 

 

 
KUVA 20. Saavutusten koodi 

 

Esimerkkipelissäni pelaaja pelaa ritarihahmolla ja kerää kultakolikkoja. Aina kun pelaaja kerää kolikon, 

kultakolikko -GameObjectin skripti nostaa kultapisteitä yhdellä. Lisään samaan skriptiin Onnenpekka-

saavutuksen eteneminen arvolla yksi viittaamalla GooglePlayOminaisuudet.cs -skriptiin seuraavalla ta-

valla: googlePlayScripti.UnlockGoogleIncAchievement(GPGSIds.achievement_onnenpekka, 1).  

 

 
KUVA 21. Saavutukset -valikko 
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Testasin Onnenpekka-saavutuksen toimintaa Android puhelimellani siirtämällä päivitetyn APK-tiedos-

ton ja pelaamalla peliä. Painamalla saavutusnappia käynnistyy Google Playn saavutukset-valikko, josta 

näkee ansaitut saavutukset ja niiden etenemisen. (KUVA 21)  

 

  
KUVA 22. Saavutuksen suorittaminen 

 

Koska päivitän Onnenpekka -saavutuksen etenemistä aina, kun pelaaja kerää uuden kolikon, pelaaja saa 

ilmoituksen reaaliajassa juuri silloin, kun pelaaja saa saavutuksen tehtyä loppuun, eli kerättyä kymme-

nen kolikkoa (KUVA 22). 

 

 

5.4 Google Play -tulostaulut 

 

Tulostaulukkoja (Eng. Leaderboards) on jo pitkään käytetty videopeleissä luomaan kilpailua ja näyttä-

mään eri pelaajien suorituksen. Google Play Services tarjoaa mahdollisuuden tulostaulukkojen helppoon 

implementointiin. Tulostaulukko luodaan Google Play -konsolin pelipalvelut-valikosta valitsemalla Tu-

lostaulukot. (KUVA 23) Kuten saavutuksia luodessa, tulee taulukon luomisen jälkeen painaa linkkiä Hae 

resurssit ja kopioida XML -koodi ja päivittää se Unity Editorissa valitsemalla Windows > Google Play 

Games > Setup > Android Setup, jotta kyseiseen taulukkoon voidaan viitata pelin koodissa. 
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KUVA 23. Uuden tulostaulukon luonti 

 

Lisätään kuvan 23 mukaisesti Social.ShowLeaderboardUI-funktio aiemmin luomaamme 

GooglePlayOminaisuudet.cs-skriptiin. Tämä funktio käynnistää Google Playn oletustulostaulunäky-

män, joka sijaitsee laitteen Google Play services -sovelluskomponentissa. Kun tämän funktion lisää 

Unity Editorissa tulostaulut-nappiin, tällöin nappia painaessa pelin tulostaulut aukeavat pelaajalle. 
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KUVA 24. Koodi tulostaulukon näyttämiseen 

 

Tulotaulukko saadaan päivitettyä komennolla PlayGamesPlatform.Instance.ReportScrote(). (Katso 

kuva 25) Esimerkissäni muuttuja ”seconds” on haluamani tallennettava arvo ja leaderboard_earth_lea-

derboard on GPGSId, joka viittaa Google Play Consolessa luomaani tulostaulukkoon. Varmistan myös, 

että pelaaja on varmasti kirjautunut sisään PlayGamesPlatform.Instance.localUser.authenticated-ko-

mennolla. 

 

 
KUVA 25. Tulostaulukon päivittäminen 

 

 

5.5 Pelin tallentaminen Googlen pilvipalveluun 

 

Tässä luvussa implementoidaan Googlen ”Saved Games” -ominaisuus peliprojektiin. Jos pelin etenemi-

nen ja tiedot tallennetaan vain pelin omiin tiedostoihin, poistuvat kaikki tallennetut tiedot sovelluksen 

poistaessa tai laitetta vaihtaessa. Tallentamalla Googlen pilvipalveluun säilyvät pelintiedot, vaikka lai-

tetta vaihtaisi tai pelin poistaisi ja asentaisi uudelleen. Tämä kuitenkin vaatii käyttäjältä Google-tilin 

omistamisen ja siihen kirjautumisen. Tiedot tallentuvat pelaajan Google Drive -sovellustietokansioon, 

joka on pelaajille näkymätön sekä suojattu peukaloinnilta. Jokaisella pelillä on oma tietokansio, jonne 

on pääsy lukemaan ja kirjoittamaan vain kyseisellä pelillä. Täten ei ole huolta, että muut sovellukset 

voisivat sotkea tietoja.  
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Tällä hetkellä yhden pelin tallennuksen koko on maksimissaan 3MB, ja mahdollisen kansikuvan maksi-

mikoko on 800KB. Tallennuksen metatietoihin on mahdollista tallentaa alla olevan taulukon (TAU-

LUKKO 1.) kaltaisia tietoja. 

 

 

TAULUKKO 1. Saved Game -ominaisuuden metadatat 

Ominaisuus (Eng. Termi) Kuvaus 

ID Google Play -pelipalveluiden luoma ainutlaatuinen merkkijono, 

jolla viitataan haluttuun tallennukseen. 

Name Pelinkehittäjän keksimä lyhyt nimi tallennukselle, jota ei näytetä 

pelaajille. 

Description Pelinkehittäjän luoma kuvausteksti tallennukselle. 

Last modified Google Play -pelipalveluiden generoima aikaleima millisekunteina: 

se kertoo, milloin tallennusta on päivitetty viimeksi. 

Played time Pelinkehittäjän antama aika millisekunteina. Se kertoo, kuinka 

kauan kyseistä tallennusta on pelattu yhteensä (esim. arvo 3600000 

näkyy pelaajalle arvona 1h eli yksi tunti). 

Cover image Kansikuva on valinnainen, mutta Googlen suosittelema. Se voi olla 

esimerkkisi kuvakaappaus pelistä tallennushetkellä.  

 

Aivan aluksi tulee kytkeä Tallennetut pelit -ominaisuus päälle Google Play Consolesta, projektin vali-

kosta Pelin tiedot. Ominaisuus laitetaan käyttöön ja tallennetaan muutokset sivun ylälaidasta painamalla 

tallenna. (KUVA 26) 

 

 
KUVA 26. Tallennetut pelit ominaisuuden käyttöönotto 

 

Enabloidaan Saved Games ohjelmointirajapinta (API) muokkaamalla aiemmin luomaamme Google 

Play Build -koodia lisäämällä ”.EnableSavedGames()” -koodin pätkä aiemmin lisättyyn skriptiin ku-

van 27 mukaisessa kohdassa. 
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KUVA 27. Saved Games -ominaisuuden aktivointi koodissa 

 

Tallentaminen Saved Games -palveluun on kaksivaiheinen prosessi. Aluksi tulee avata tiedosto, jota 

kutsutaan nimellä snapshot ja jonne data halutaan tallentaa. Tämän jälkeen tieto kirjoitetaan tiedostoon 

ja päivitys lähetetään palvelimelle, minkä jälkeen snapshot suljetaan. Lisätään skriptin alkuun viittaus 

”using GooglePlayGames.BasicApi.SavedGame;”,  jotta päästään käyttämään Saved Games -kirjas-

toja. (KUVA 28) 

 

 
KUVA 28. Google Play Games -kirjastot 

 

Seuraavaksi päätetään, mitä pelille ominaista tietoa bittijonoon tallennetaan. Itse tallennan ennätyksen 

ja kultakolikkojen määrän luomassani GetSaveString-funktiossa. Tallennan arvot samaan merkkijonoon 

erottaen nämä kaksi lukua poikkiviivalla. Tämä merkkijono muutetaan varsinaiseen bittijonoon myö-

hemmin toisessa funktiossa. (KUVA 29) 

 

LoadSaveString-funktio on käänteinen funktio GetSaveString-funktiolle. Merkkijonon ensimmäinen 

arvo ”HighScore” ja toinen arvo ”GoldCoins” erotetaan C#-funktiolla split, joka jakaa merkkijonon an-

netun merkin kohdalla eli kyseisessä tapauksessa poikkiviivan kohdalla. Tämän jälkeen tietoja voidaan 

käyttää pelikoodissa halutulla tavalla. Itse tallennan ne GameInformation -nimiseen skriptiin. 
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KUVA 29. Esimerkki tietojen tallentamisesta 

 

Loin AvaaTallennus -nimisen funktion, joka ottaa parametrina tallennus -nimisen booelan muuttujan 

(KUVA 30). Logiikkana on, että jos funktiolle annetaan arvo true, tallennus avataan, mikä tarkoittaa 

tallentamista. Jos taas annetaan arvo false, tämä tarkoittaa, että ei olla tallentamassa, eli tässä tapauksessa 

ladataan tallennus. Tämä AvaaTallennus-funktio avaa snapshotin jatkokäsittelyä varten. 

 

 
KUVA 30. Pilvitallennus -koodi 

 

AvaaTallennus-funktio kutsuu sisällään TallennusAvattu-funktiota, joka on toinen luomani funktio itse 

tallennusprosessia varten (KUVA 31). Jos ollaan tallentamassa, tämä funktio luo varsinaisen bittijonon 

GetSaveString-funktion palauttamasta merkkijonosta. Social.Active.SavedGame.CommitUpdate-

komennolla tallennuksen päivitys lähetetään palvelimelle. Tämä funktio ottaa vaihtoehtoisia tallennus-

metatietoja sisäänsä parametrien muodossa.  
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KUVA 31. Tallennuksen avaaminen 

 

Jos ei olla tallentamassa eli ollaan lataamassa tallennusta, TallenusAvattu funktio suorittaa SaveRead-

funktion. SaveRead-funktio purkaa bittijonon ja kutsuu aiemmin luotua LoadSaveString-funktiota lähet-

tämällä puretun merkkijonon parametrina. 

 

  
KUVA 32. Avatun tallennukseen päivittäminen 

 

Nyt tallennuksen logiikka on luotu. Seuraavaksi tulee päättää, missä pelikoodin kohdassa halutaan lä-

hettää tallennuksen päivitys Google Playn palvelimille. Itse lähetän päivityksen pelikierroksen lopussa, 

joten lisään viittauksen GooglePlayOminaisuudet-skriptiin pelini skriptissä, joka suoritetaan, kun pelaaja 

häviää. Tulostaulun päivitys on myös tässä skriptissä, joten laitan pilvitallennuksen suoraan tämän pe-

rään. 
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Koska GooglePlayOminaisuudet-skripti tallennusfunktioneineen sijaitsee Canvas-nimisen GameObjek-

tin komponenttina, joudun etsimään sen Unityn GameObject.Find().GetComponent -komennolla. 

Asetan sen myös luomaani muuttujaan ”gpOminaisuudetScript”, jotta sitä on helppo käyttää funktioissa. 

(Esimerkki viittaamisesta skriptiin alla olevassa kuvassa 33.)  

 

 
KUVA 33. Viittaaminen GooglePlayOminaisuudet.cs -skriptiin 

 

Seuraavaksi kutsutaan tallentamisen aloittamista komennolla gpUIScript.AvaaTallennus(true). Tämä 

aloittaa tallentamisen pilveen viittauksen kautta, koska funktion (true) tarkoitti, että tallennus-snapshot 

avataan, mikä näin ollen tarkoittaa tallentamisen aloittamista. (KUVA 34) 

 

 
KUVA 34. Pilvitallennuksen tekemisen kutsuminen pelikoodissa. 

 

Nyt tallennuksen tiedot on päivitetty palvelimelle. Lisäämällä pelin alkuun gpOminaisuudetScript.Avaa-

Tallennus() arvolla false saadaan käynnistettyä tietojen lataaminen, josta tiedot voidaan sitten asettaa 

haluttuihin muuttujiin käytettäväksi pelissä. 
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Ensimmäinen ideani opinnäytetyöni aiheesta oli tehdä opinnäytetyö mobiilipelin kehityksestä, mutta 

päädyin kuitenkin rajaamaan aiheeni Google Play -pelipalveluihin, koska tahdoin oppia aiheesta enem-

män ja se on tärkeä vaihe Android-mobiilipelin kehityksessä. Google Play ja sen ominaisuudet ovat niin 

laajasti käytettyjä mobiilipeleissä, että pelaajat pitävät niitä lähes normaaleina ominaisuuksina Android-

peleille.  

 

Tämän opinnäytetyön tavoitteena oli implementoida Google Play -pelipalvelun ominaisuuksia Unity-

pelimoottorissa kehityksessä olevaan Android-mobiilipeliini ja samalla luoda opas muille helpottamaan 

tätä prosessia. Oppaan laadinnassa käytin lähteinä pääasiassa Googlen tekemiä Android-sovelluskehit-

täjille tarkoitettuja yleisiä oppaita. 

 

Opinnäytetyön tavoite onnistui hyvin. Opas on selkeä suomenkielinen vaiheittain etenevä ohjeistus, 

jossa kuvat täydentävät tekstiosuutta. Oppaan olisi voinut laatia myös englannin kielellä, sillä englanti 

on kieli, jota pääasiassa käytetään ohjelmoinnissa, koska termien kääntäminen suomeksi on haasteellista. 

 

Opin paljon Google Playn implementoinnista ja sain lisättyä nämä ominaisuudet omaan peliprojektiini. 

Aion jatkaa opinnäytetyössä esimerkkinä käyttämäni peliprojektini kehittämistä julkiseen julkaisuun 

asti.  
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